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5. САПР фильтров AnadigmFilter

AnadigmFilter — это мощный инструмент,

позволяющий разрабатывать более сложно ор-

ганизованные фильтры, чем имеющиеся в ба-

зе стандартных конфигурируемых аналоговых

модулей. Стандартные библиотеки КАМ содер-

жат лишь фильтры первого и второго поряд-

ков, в которых пользователь устанавливает

только величины частоты среза, усиление и до-

бротность. Стандартные библиотечные эле-

менты фильтров могут быть сгруппированы

в фильтры более высоких порядков, но для то-

го, чтобы сделать это наиболее эффективно,

необходимо использовать дополнительные

справочные материалы по разработке фильт-

ров и выполнять громоздкие вычисления вруч-

ную. В качестве альтернативы выступает инст-

румент AnadigmFilter, полностью автоматизи-

рующий процесс разработки и реализации

фильтров более высоких порядков. Доступ

к этому инструменту осуществляется путем

выбора пункта меню Tools → AnadigmFilter.

В главном окне AnadigmFilter расположе-

ны все основные элементы управления, пред-

ставляющие интерес для большинства поль-

зователей. Разработка и реализация фильт-

ров может быть выполнена за четыре шага.

На рис. 1 есть цифровые ссылки, соответст-

вующие каждому из этих шагов:

1. Задайте в AnadigmFilter частоту главного

генератора синхронизирующих сигналов.

2. Выберите тип разрабатываемого фильтра:

ФНЧ (Low Pass), ФВЧ (High Pass), полосовой

(Band Pass) или режекторный (Band Stop).

3. Переместите границы предела чувствитель-

ности фильтра до необходимых значений

частот и усиления.

4. Щелкните по кнопке To AnadigmDesigner®2.

AnadigmFilter синтезирует фильтр с требу-

емыми параметрами и экспортирует его

в AnadigmDesigner®2. САПР фильтров создаст

столько экземпляров ПАИС, сколько необходи-

мо для реализации заданной АЧХ, и заполнит

эти экземпляры конфигурируемыми модуля-

ми фильтров низкого порядка, удовлетворяю-

щих всему набору параметров и соединений для

реализации фильтра более высокого порядка.

Мы заканчиваем серию статей, посвященных новому продукту на российском
рынке электронных компонентов — программируемым аналоговым
интегральным схемам (ПАИС). В этом цикле мы кратко рассмотрим две
подпрограммы, входящие в комплект AnadigmDesigner®2 — системы
автоматизированного проектирования фильтров и пропорционально1
интегрально1дифференциальных регуляторов.

Окончание. Начало в № 7'2005. Система автоматизированного
проектирования 
программируемых аналоговых

интегральных схем AnadigmDesigner®2

Часть 2. Особенности разработки проектов 
в среде программирования ПАИС Anadigm

Рис. 1. Главное окно AnadigmFilter Рис. 2. Главное окно AnadigmFilter с отображением диаграммы Бодэ
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Фильтры более высоких порядков могут быть

разработаны и реализованы за считанные ми-

нуты. В основном окне AnadigmFilter имеют-

ся элементы управления для настройки типа

аппроксимации (Butterworth, Chebyshev,

Inverse Chebyshev, Elliptical и Bessel). Также

имеются элементы для ввода текста, позволя-

ющие задавать параметры фильтра не графи-

ческим способом, а путем указания точных

значений величин. При нажатии кнопки

To AnadigmDesigner®2 информация передается

из AnadigmFiltеr в AnadigmDesigner®2.

В меню View можно включить отображе-

ние нулей и полюсов фильтра на диаграмме

Бодэ (рис. 2).

На рис. 3 показана реализация ФНЧ

в AnadigmDesigner®2 с характеристикой Чебы-

шева с параметрами, приведенными на рис. 1.

5.1. Анализ данных

Данные отклика фильтра можно экспор-

тировать для дальнейшего анализа при по-

мощи команды меню File → Export →

Frequency Response Data (.CSV). В файле форма-

та .csv содержатся данные (в виде столбцов)

для частоты, амплитуды в дБ и относитель-

ных единицах, фазы и групповой задержки.

5.2. Распечатка отчетов

По выбору пункта меню File → Print фор-

мируется распечатка на нескольких листах,

аналогичная приведенной на рис. 4. 

5.3. Более полное описание возможностей

Справочная система AnadigmFilter содер-

жит исчерпывающую информацию, поэто-

му детальное рассмотрение возможностей

AnadigmFilter можно изучить самостоятельно.

6. САПР PID1регуляторов
AnadigmPID

6.1. Несколько слов о PID-регуляторах

Хотя существует много вариантов схемотех-

нических решений для управления замкнуты-

ми системами с обратной связью, однако все они

сводятся к обеспечению одного из методов регу-

лирования: пропорционального (P), пропорци-

онально-интегрального (PI) или пропорциональ-

но-интегрально-дифференциального (PID).

Пропорциональный метод регулирования

является наиболее простым.

При его реализации из сигнала обратной свя-

зи вычитается опорный сигнал, определяющий

рабочую точку системы. Полученный сигнал

рассогласования усиливается в KP раз и пода-

ется на выходной усилитель или исполнитель-

ное устройство, которое обеспечивает требуе-

мое изменение управляемого параметра. Функ-

ция регулирования P-регулятора имеет вид:

u(t) = KP<x(t)                  (1)

где x(t) — сигнал ошибки, u(t) — сигнал уп-

равления, KP — постоянный коэффициент

передачи.

Этот метод может быть использован в про-

стых системах регулирования, не требующих

высокой точности.

Однако при его использовании приходит-

ся выбирать между точностью и устойчиво-

стью схемы. При низких значениях KP воз-

никает остаточная ошибка, которая тем вы-

ше, чем ниже KP .

Увеличение усиления сигнала ошибки по-

вышает точность, но приводит к возникно-

вению осцилляций в режиме установления,

что неприемлемо в системах, требующих од-

новременно и высокой скорости и точности.

Частично свободна от указанных недостат-

ков схема, реализующая пропорционально-

интегральный метод регулирования.

Она содержит два канала — пропорцио-

нальный и интегральный. Сигналы с выхо-

дов обоих каналов суммируются, а результи-

рующий сигнал подается на выходной уси-

литель мощности. Функция регулирования

PI-регулятора имеет вид:

(2)

где Ki — постоянный коэффициент переда-

чи интегрального канала. Чем больше сигнал

ошибки, тем больше будет вклад интеграль-

ного канала в результирующий сигнал уп-

равления. Наличие интегральной составля-

ющей в сигнале управления позволяет зна-

чительно снизить остаточную ошибку.

В установившемся режиме сигнал ошибки

стремится к нулю, соответственно и интег-

ральная составляющая в выходном сигнале

также будет стремиться к нулю.

Если в P-регуляторе отклик на изменение

входного сигнала линейно пропорционален

ошибке, то в PI-регуляторе величина отклика

будет изменяться в зависимости от величины

ошибки. Хотя остаточная ошибка в такой сис-

теме управления значительно ниже, в динами-

ческом режиме работы приходится искать

компромисс между скоростью реакции и ус-

тойчивостью. Это достигается подбором ко-

эффициентов усиления каналов KP и Ki . Боль-

шое усиление позволяет системе быстрее до-

стичь рабочей точки, но при этом есть опасность

возникновения переходных процессов.

Наоборот, низкое усиление приведет к не-

достаточному быстродействию регулятора.

Обычно регулировкой усиления каналов до-

биваются компромиссного режима с быст-

рым затуханием переходного процесса.

Добавление к PI-регулятору дополнитель-

ного дифференциального канала позволяет

повысить запас устойчивости по фазе и уве-

личить усиление KP и Ki (снизив время уста-

новления), и одновременно устранить пере-

ходной процесс, поскольку система начнет

«чувствовать» не только наличие ошибки,

но и тенденцию к ее изменению.

Функция регулирования PID-регулятора

имеет вид:

(3)

где Kd — коэффициент передачи дифферен-

циального канала.

Рис. 3. Синтезированный ФНЧ 

с характеристикой Чебышева

Рис. 4. Пример распечатки отчета AnadigmFilter
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Если скорость изменения сигнала обратной

связи слишком высока, то эточто может

явиться причиной перерегулирования или

возникновения осцилляций, дифференциаль-

ный канал уменьшает уровень сигнала на вхо-

де сумматора, что приводит к ее снижению.

6.2. Разработка схем регуляторов

в САПР AnadigmPID

AnadigmPID — мощное средство для раз-

работки замкнутых систем с обратной свя-

зью. Он позволяет разрабатывать регулято-

ры в любом сочетании, включая формы I, PI,

PD и PID. Основные входные параметры раз-

работки — это коэффициенты усиления каж-

дого из каналов регулятора. Данные разра-

ботки схемы контроллера автоматически

(и непрерывно) передаются из AnadigmPID

в AnadigmDesigner®2.

Создание новой разработки замкнутого

контура схемы управления начинается с от-

крытия в AnadigmDesigner®2 нового проек-

та. Хотя в разработке еще нет ни одного эк-

земпляра ПАИС, полезно сразу сохранить эк-

земпляр под каким-либо значащим именем,

а также сохранить файл .ad2 с каким-нибудь

подходящим именем.

САПР AnadigmPID вызывается путем вы-

бора пункта меню Tools → AnadigmPID.

При первом вызове AnadigmPID требует-

ся указать экземпляр ПАИС, в который

в дальнейшем будут экспортированы данные

разработки (рис. 5). Обычно бывает открыт

для редактирования только один экземпляр

ПАИС, если же в AnadigmDesigner®2 откры-

то несколько схем, то в окне Circuits Options

можно выбрать необходимый экземпляр.

Как только это окно будет закрыто, откро-

ется основное окно AnadigmPID (рис. 6).

В верхней части основного окна AnadigmPID

расположены вкладки Design Notes, Block

Diagram и TransferFx (Transfer Function).

Ниже будет рассмотрена только вкладка Block

Diagram. В нижней части основного окна

AnadigmPID также расположены вкладки:

System, Filter, Properties и Input.

Вкладка System

На вкладке System показан тип ПАИС,

в приведенном примере это AN221E04.

При нажатии кнопки Select открывается окно

Circuits options, рассмотренное выше.

В элементе ввода Master Chip Clock указы-

вается ожидаемая частота основного генера-

тора синхросигнала.

Controller type: элемент управления с выпа-

дающим списком, содержащим значения P,

PI, PD и PID топологии контроллера

(Proportional, Integral и Differential).

Элемент ввода Offset Compensation добав-

ляет смещение постоянной составляющей

на выход схемы контроллера.

Вкладка Filter

На вкладке Filter указывается, будет ли ис-

пользован фильтр НЧ на выходе контролле-

ра, и устанавливаются значения параметров

для этого фильтра. Доступные типы фильт-

ров — это билинейный или биквадратный

более высоких порядков. Величина констан-

ты фильтра обычно указывает частоту среза

в герцах. Также эту величину можно указать

в рад/с или в виде постоянной времени в се-

кундах.

Вкладка Properties

На вкладке Properties указываются значе-

ния констант для всех каналов схемы кон-

троллера. Есть элементы ввода для KP, KI и KD .

Необходимые величины вводятся в столбец

Requested Column. В столбце Realized отобра-

жаются значения, которые могут быть достиг-

нуты в AnadigmPID. 

Диапазоны достижимых значений не явля-

ются полностью независимыми друг от друга.

В частности, значение частоты, установлен-

ное в элементе ввода Signal Path Clock, озна-

чает значение частоты, подаваемое на каждый

из КАМ на пути прохождения сигнала. Изме-

нение этого значения влечет за собой измене-

ния на всем пути прохождения сигнала, а так-

же изменение диапазонов достижимых зна-

чений для каждого КАМ. При нажатии

на любую из гиперссылок в этом окне откро-

ется окно с подробной справочной информа-

цией по выбранной величине.

Последний элемент управления, располо-

женный на этой вкладке — это «флажок»

Show f ine tuning slider controls. При выборе

этого элемента управления открывается ок-

но, аналогичное изображенному на рис. 7.

Использование этого элемента наиболее по-

лезно в сочетании с функцями меню Circuit →

Continuous Download to Board. Использование

«бегунков» во время непрерывной загрузки

конфигурационных данных в систему поз-

воляет производить настройку схем контрол-

лера, созданных при помощи AnadigmPID,

в реальном масштабе времени.

94 компоненты рубрика
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Рис. 6. Главное окно AnadigmPID

Рис. 7. «Бегунки» для точной настройки — удобный инструмент для настройки систем в реальном масштабе времени

Рис. 5. Выбор ПАИС для разработки
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Вкладка Input

На вкладке Input (рис. 8) расположены эле-

менты управления некоторыми аспектами

входов схемы контроллера. Масштабирова-

ние или инвертирование могут быть приме-

нены к сигналу обратной связи PV от датчи-

ка исполнительного устройства.

Аналогично масштабирование или инвер-

тирование можно применить и к сигналу ус-

тановки рабочей точки Set Point (SP).

Выбор масштабирования сигнала добавля-

ет усилитель на блок-схеме, как показано

на рис. 8. Аналогично выбор инвертирования

добавляет иконку на блок-схему для визуаль-

ного напоминания о выбранной настройке.

Internal Set Point — это один из вариантов

установки рабочей точки, доступных в эле-

менте с выпадающим списком Set Point (SP).

При выборе этого варианта в ПАИС добавля-

ется источник опорного напряжения Set Point.

Это полезно для приложений, в которых ра-

бочая точка инвариантна, или же ее значение

должно меняться при динамическом пере-

конфигурировании с помощью управляю-

щего процессора.

6.3. Автоматическая передача

разработанных данных

Схемы, разработанные при помощи

AnadigmPID, передаются в режиме реально-

го времени на тот экземпляр ПАИС

в AnadigmDesigner®2, который был указан в на-

чале разработки. Соединения помечены мет-

ками SP, PV и CV, соответствующими Set Point,

Plant Feedback и Controller Output (рис. 9).

По окончании разработки контроллера PID

(PI, PD или P), дальнейшая его модификация

может осуществляться стандартными сред-

ствами AnadigmDesigner®2.

Справочная система AnadigmPID содержит

исчерпывающую информацию, поэтому воз-

можности AnadigmFilter можно изучить са-

мостоятельно.

Заключение к циклу статей

На протяжении всего года мы публикова-

ли цикл статей, посвященный уникальному

для нашего рынка продукту — программи-

руемым аналоговым интегральным схемам.

Несмотря на ограниченные пока ресурсы, эти

приборы открывают большие возможности

при создании комбинированных аналого-ци-

фровых систем обработки сигналов.

За истекший год количество пользовате-

лей продукции Anadigm перевалило за сот-

ню, многие проекты доведены до серийного

производства. Уже сейчас по имеющимся от-

зывам можно отметить, что ПАИС в целом

обеспечивают заявленные характеристики,

а простота разработки проектов значитель-

но сокращает время на изучение САПР.

Мы надеемся, что этот цикл публикаций

поможет начинающим пользователям не толь-

ко разобраться в принципах построения и ра-

боте с ПАИС, но и сократить время до начала

разработки проектов. ■

Рис. 8. Установка вариантов конфигурации входов регулятора=

Рис. 9. Автоматически синтезированный регулятор
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